@ HP Z1 Workstation

User Guide



Copyright Information
First Edition: March 2012
Part number: 685866-001

Warranty

Hewlett-Packard Company shall not be
liable for technical or editorial errors or
omissions contained herein or for incidental
or consequential damages in connection
with the furnishing, performance, or use of
this material. The information in this
document is provided “as is” without
warranty of any kind, including, but not
limited to, the implied warranties of
merchantability and fitness for a particular
purpose, and is subject to change without
notice. The warranties for HP products are
set forth in the express limited warranty
statements accompanying such products.

Nothing herein should be construed as
constituting an additional warranty.

This document contains proprietary
information that is protected by copyright.
No part of this document may be
photocopied, reproduced, or translated to
another language without the prior written
consent of Hewlett-Packard Company.

Trademark Credits

The HP logo is a trademark of Hewlett-
Packard Company in the U.S. and other
countries.

Microsoft and Windows are U.S. registered
trademarks of Microsoft Corporation.

Intel is a trademark of Intel Corporation in
the U.S. and other countries and is used
under license.

Acrobat is a trademark of Adobe Systems
Incorporated.

ENERGY STAR is a U.S. registered mark of
the United States Environmental Protection
Agency.



About this guide

This guide provides setup and basic troubleshooting information for the HP Z1 Workstation. It includes
these topics:

Guide topics

Locating HP resources on page 1

HP Z1 Workstation features on page 6

Setting up and using the workstation on page 10

Setting up and restoring Microsoft Windows on page 21

Setting up and restoring Linux on page 23

Updating the workstation on page 28

Diagnostics and Minor Troubleshooting on page 30

Routine Care on page 36

- TIP: I you do not find what you are looking for in this guide:

— Find technical details in the HP Z1 Workstation Maintenance and Service Guide at
http://www.hp.com/support/workstation_manuals.

— View removal and replacement videos at http://www.hp.com/go/sml.

— See additional information on your workstation at http://www.hp.com/go/workstations.
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1 Locating HP resources

This section provides information on the following HP resources for your workstation:

Topics

Product information on page 2

e  Technical specifications

e  HP Cool Tools

Regulatory information

e  Accessories

System board

e  Serial number and Certificate of Authenticity labels

Support on page 3

e  Product support
e  HP Support Assistant

e  Warranty information

Product documentation on page 4

e  HP and third-party documentation, white papers
e  Product notifications
e  Technical specifications (QuickSpecs)

e  Customer Advisories, Security Bulletins, Notices

Product diagnostics on page 4

e  Diagnostics tools
e  Audible beeps and LED code definitions

e POST error codes

Product updates on page 5

e  Driver and BIOS updates

e  Operating systems
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Product information

Table 1-1 Product information

Topic

Location

Technical specifications

Go to www.hp.com/go/quickspecs. In the left pane, select your region and then
select Workstations.

HP Cool Tools

Most HP Microsoft Windows workstations are preloaded with tools that may enhance
system performance and with additional software that is not automatically installed
during first boot. To access these applications:

e  Click the HP Cool Tools icon on the desktop, or

e  Open the HP Cool Tools folder by selecting Start > All Programs > HP >
HP Cool Tools.

To learn more about these applications, click HP Cool Tools—Learn More.

To install or launch the applications, click the appropriate application icon.

Regulatory information

Refer to the Safety & Regulatory Information guide for product Class information. You
can also refer to the label on the workstation chassis.

Accessories

For complete and current information on supported accessories and components, see
http://www.hp.com/go/workstations.

System board

A diagram of the system board is located on the inside of the side access panel
(tower and deskiop configurations) or on the inside of the chassis (all-in-one
configurations). Additional information is located in the Maintenance and Service
Guide on the Web at http://www.hp.com/support/workstation_manuals/.

Serial number and Certificate of

Authenticity (COA) labels (if

Serial number labels are on the top or back panel (tower and deskiop configurations)
or on a pull-out card on the side of the display (all-in-one configuration). The COA

applicable) label is typically located near the serial number label. Some workstations have this
label on the bottom panel.
Linux For information on running Linux on HP workstations, go to http://www.hp.com

linux/, then select Linux on Workstations from the list on the left.

Chapter 1 Locating HP resources
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Support

Table 1-2 Support

Topic

Location

Product support

For U.S. support, go to http://www.hp.com/go/contactHP.

For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact _us.html.

Here you can:

e  Chat online with an HP technician
e  Obtain E-mail support

e  Find support telephone numbers

e locate an HP service center

HP Support HP Support Assistant is an HP application that helps you maintain the performance of your workstation
Assistant and resolve problems through automated updates and tune-ups, builtin diagnostics, and guided
assistance.
To access HP Support Assistant, double-click the HP Support Assistant icon on your desktop.
NOTE: HP Support Assistant is pre-installed on all HP workstations running Microsoft Windows 7. HP
Support Assistant is not available on workstations running Linux.
Warranty To locate base warranty information, see http://www.hp.com/support/warranty-lookuptool.
information

To locate an existing Care Pack, see http://www.hp.com/go/lookuptool.

To extend a standard product warranty, see http://h20219.www?2.hp.com/services/us/en/warranty
carepack-overview.html. HP Care Pack Services offer upgraded service levels to extend and expand a
standard product warranty.

For some countries/regions, a printed HP Limited Warranty is provided in the box. In countries/regions
where the warranty is not provided in printed format, you may request a printed copy from
www.hp.com/go/orderdocuments or write to:

e North America: Hewlett Packard, MS POD, 11311 Chinden Blvd, Boise, ID 83714, USA

e Europe, Middle East, Africa: Hewlet-Packard, POD, Via G. Di Vittorio, 9, 20063, Cernusco
s/Naviglio (M), ltaly

e  Asia Pacific: Hewlett-Packard, POD, P.O. Box 200, Alexandra Post Office, Singapore 911507

Please include your product number, warranty period (found on your serial number label), name and
postal address.

Support
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Product documentation

Table 1-3 Product documentation

Topic Location
HP user documentation, white For the latest online documentation, go tohttp://www.hp.com/support
papers, and third-party workstation_manuals. These include this User Guide and the Maintenance and
documentation Service Guide.

Removal and replacement videos  To learn how to remove and replace workstation components, go to
http://www.hp.com/go/sml.

Product notifications Subscriber's Choice is an HP program that allows you to sign up to receive driver
and software alerts, proactive change notifications (PCNs), the HP newsletter,
customer advisories, and more. Sign up at www.hp.com/united-states/subscribe
gateway/?jumpid=go/subscribe-gate1.

Customer advisories and product change notifications are also available on
http://www.hp.com/go/bizsupport/.

Technical specifications The Product Bulletin contains QuickSpecs for HP Workstations. QuickSpecs include
information the operating system, power supply, memory, CPU, and many other
system components. To access the QuickSpecs, see http://www.hp.com/go

quickspecs/.

Customer Advisories, Security To find advisories, bulletins, and notices:

Bulletins, and Notices )
1. See http://www.hp.com/go/workstationsupport.

2. Select the desired product.
3. From the Resources section, select See more...
4

. Use the scroll bar to select Customer Advisories, Customer Bulletins, or
Customer Notices.

Product diagnostics

Table 1-4 Product diagnostics

Topic Location

Diagnostics tools The HP Vision Diagnostics utility is pre-installed on Windows 7 systems. To transfer it
to an optical disc or USB flash drive, click Start > All Programs > HP Help &
Support > HP Vision Diagnostics Disk Creation.

Audible beep and LED code Refer to the workstation Maintenance and Service Guide at http://www.hp.com
definitions support/workstation_manuals.
POST error codes Refer to the workstation Maintenance and Service Guide at http://www.hp.com

support/workstation_manuals.

4 Chapter 1 Locating HP resources
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Product updates

Table 1-5 Product updates

Topic

Location

Driver and BIOS updates

See http://www.hp.com/go/workstationsupport to verify that you have the latest
drivers for the workstation.

To determine the current workstation BIOS on your workstation, follow these steps
during system power up:

1.
2.
3.

Power on the workstation, and press Ese during boot up..
Press F10 to enter the F10 Setup utility.

Go to File > System Information. Note the BIOS version and date and
compare it with the BIOS versions that appear on the HP website.

Alternatively, on Windows 7 systems you can:,You can also find the BIOS version
under Windows 7 by going to All Programs > Accessories > System Tools > System
Information > In the right pane, find the line with "BIOS Version/Date. Note the BIOS
version and date and compare it with the versions that appear on the HP website.

1.

Go to Start > All Programs > Accessories > System Tools > System
Information.

In the right pane, find the line with BIOS Version/Date.

Note the BIOS version and date and compare it with the versions that appear
on the HP website.

Operating systems

For additional information, on:

Operating systems supported on HP workstations, go to http://www.hp.com

9O/ WSO0s.

Windows operating systems, go to http://www.microsoft.com/support.

Linux operating systems, go to http://www.hp.com/linux.

Product updates
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2 HP Z1 Workstation features

For complete and current information on supported accessories and components for the workstation,
see http://partsurfer.hp.com.

Components

Front and bottom components

Figure 2-1 Front and bottom components

Table 2-1 Component descriptions

1 Camera angle adjustment dial 5 Serial number pull-out card
2 Camera 6 Speakers

3 Left and right digital microphones 7 Stond

4 Display 8 Chassis latches

6 Chapter 2 HP Z1 Workstation features


http://partsurfer.hp.com

Side components

Figure 2-2 Side components

Table 2-2 Component descriptions

G

Power button

>
IIO'

|IEEE-1394a FireWire connector

Hard drive activity light

Ss<%

USB 3.0 connectors (2)

Slotload optical drive eject button

Headphone connector

Slotload optical drive

Microphone connector

: 8
PN
4
5

xD/MMC/MS/SD card reader

Components
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Rear components

Figure 2-3 Rear components (excluding stand)

Table 2-3 Component descriptions

1 Handle 6 Power cord connector
2 ‘Sub Subwoofer connector (orange) 7 - USB 2.0 connectors (4)
3 ((':}P Audio line-out connector (green) 8 S/PDlF Optical S/PDIF audio output

H

(3 Audio line-in connector (blue) 9 $ RJ-45 network connector

(4]

DiSplePOI'f DisplayPort connector 10 Cable lock slot

Chapter 2 HP Z1 Workstation features



Product specifications

Physical characteristics

Table 2-4 Physical characteristics

With stand 21.3 kg (47.0 Ibs)
Weight Without stand 15.4 kg (34.0 lbs)
Stand only 5.9 kg (13.0 lbs)
Upright, excluding stand Height: 584.2 mm (23.0 in)
Width: 660.4 cm (26.0 in)
Dimensions Depth: 419.1 cm (16.5 in)

Stand only Height: 457.2 cm (18.0 in)
Width: 660.4 cm (26.0 in)
Depth: 81.3 cm (3.2 in)

Environmental specifications

Table 2-5 HP Workstation environmental specifications

Temperature

Operating: 5°C to 35°C (40°F to 95°F)
Non-operating: -40°C to 60°C (-40°F to 140°F)

NOTE: The ambient upper limit of 35°C is good up to 1524 m (5000 fi) elevation. Derate by
1°C for every 305 m (1000 ft) above 1524 m (5000 ft). For example, at 3,048 m (10,000 f),
the upper ambient air temperature limit is 30°C.

Humidity

Operating: 8% to 85% relative humidity, non-condensing

Non-operating: 8% to 90% relative humidity, non-condensing

Altitude

Operating: 0 to 3,048 m (10,000 )
Non-operating: 0 to 9,144 m (30,000 ff)

Shock

Operating: V2sine: 40g, 2-3ms
Non-operating:

e  Yasine: 160 cm/s, 2-3ms (~100g)
e square: 422 cm/s, 20g

NOTE: Values represent individual shock events and do not indicate repetitive shock events.

Vibration

Operating random: 0.5g (rms), 5-300 Hz
Non-operating random: 2.0g (rms), 10-500 Hz

NOTE: Values do not indicate continuous vibration.

Product specifications



3 Setting up and using the
workstation

Topics

Setting up the workstation on page 10

Display options on page 18

Using the Webcam on page 20

Installing optional components on page 20

Security on page 20

Product recycling on page 20

Setting up the workstation

Location and ventilation

Proper ventilation for the system is important for workstation operation. To ensure adequate ventilation:
e  Operate the workstation on a sturdy, level surface.
e Provide at least:

° 12 cm (4.7 in) clearance at the front, back, top, and bottom of the workstation

o 16 cm (6.3 in) clearance on the right side for the optical drive

e  Ensure that the ambient air temperature surrounding the workstation falls within the specified limits
(see Environmental specifications on page 9).

e  Never restrict the incoming or outgoing airflow of the workstation by blocking any vents or air
intakes.

10 Chapter 3 Setting up and using the workstation



Setup procedure

1. Read the following warnings. It is your responsibility to understand and comply with them.

/\ WARNING! The workstation weighs 21.3 kg (47.0 lbs). If you cannot safely lift the
workstation, have someone help you remove it from the box.

/\ WARNING! To reduce the risk of electric shock or damage to your equipment:
— Plug the power cord into an easily accessible, grounded (earthed) three-pin outlet.

— Do not disable the power cord grounding pin (for example, by attaching a two-pin adapter). It
is an important safety feature.

— To disconnect power from the workstation, unplug the power cord from the AC outlet.

2. Carefully remove the workstation from the box and place it on a sturdy, level surface. Remove all
plastic packaging.

3. Push down firmly on the workstation to unload the latch in the stand.

Figure 3-1 Unload the latch

4. With one hand, grasp the bottom edge of workstation in a way that allows you to press the green
button on the stand (1). Grasp the handle at the top of the workstation with your other hand (2).
Push the green button and hold it in while you raise the workstation to its maximum horizontal

height (3).

Figure 3-2 Raise workstation

Vg

2»NOTE:  Because the workstation is heavy and the stand joints are tight, you may need to exert
some force to raise the workstation.

Setting up the workstation 11



5. Connect the power cord to the workstation.

Figure 3-3 Connect power cord

2 NOTE: It you do not plan to use the wireless LAN, connect an RJ-45 cable to the workstation.

6. Maneuver the workstation to the desired angle.

Figure 3-4 Maneuver to upright position

2 NOTE:  Because the workstation is heavy and the stand joints are tight, you may need to exert
some force to maneuver the workstation.
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7. Route the power cord through the stand and plug it into an easily accessible, grounded (earthed)
three-pin outlet. If you are using an Internet cable, route it through the stand and connect it to your
router or LAN device.

Figure 3-5 Route power cord

-

8. Press the power button (1).
Figure 3-6 Power button

2»NOTE: The Microsoft Windows 7 operating system installs when you power up the workstation
for the first time. For details, refer to Setting up and restoring Microsoft Windows on page 21.

If you are installing a Linux operating system, go to Setting up and restoring Linux on page 23.

Setting up the workstation 13
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Turn on the power on the bottom of the mouse (1) and remove the battery tab on the bottom of the
keyboard. Make sure the mouse and keyboard are within 30 cm (12 in) of the workstation and
away from interference from other devices. Press the connect button on the mouse (2) for five

seconds, then press the connect button on the keyboard (3) for five seconds. Place them in front of
the workstation.

Figure 3-7 Activate wireless keyboard and mouse

[ NOTE: The workstation has an internal USB port for the wireless keyboard/mouse receiver. If

you:
— Ordered a keyboard and mouse with your workstation, the receiver is already installed.

— Order a wireless keyboard and mouse as an aftermarket option, see Installing the USB
keyboard/mouse receiver on page 16 for instructions on installing the receiver.

— Did not order a keyboard and mouse, you can plug a wired USB keyboard and mouse into the
ports on the workstation.

Chapter 3 Setting up and using the workstation



Connecting to the Internet

The HP Z1 Workstation has built-in wireless LAN and also supports wired LAN.

e  For a wireless network connection, use a wireless router with the computer to connect to a WLAN
with an Internet connection. When the you configure Windows the first time, WLAN is
automatically turned on and enabled. All wireless networks available in the area are shown.
Choose the appropriate network.

Figure 3-8 Wireless LAN

W

e  For a wired network connection, connect an Ethernet cable to the computer and to a network
router or LAN device.

Figure 3-9 Wired LAN
U —————————ggmmmm;

Enabling Bluetooth Devices

The workstation is Bluetooth-enabled. To connect a Bluetooth wireless device:

1. Make your Bluetooth device send out a radio signal so that it is discoverable by the workstation
(refer to the device documentation for instructions).

2. In the Windows Control Panel, go to Hardware and Sound.

e If your Bluetooth device is a printer, click Printers, click Add a printer, and follow the on-

screen instructions.

e  For all other devices, click Bluetooth Devices, click Add, and then follow the on-screen
instructions.

Setting up the workstation
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Installing the USB keyboard/mouse receiver

If you order a wireless keyboard and mouse as an after-market option, follow these steps to install the
keyboard/mouse receiver.

1. Turn off the workstation, then unplug the power cord from the power outlet.

2. Holding the workstation firmly at the center of the top and bottom, maneuver the workstation into a
horizontal position.

Figure 3-10 Maneuver workstation to horizontal position

3. Slide the latches on the bottom of the workstation outward and open the chassis.

Figure 3-11 Open chassis
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4. |Install the receiver in the internal USB port on the rear |/O assembly.

Figure 3-12 Install receiver

2»NOTE: An outline around the internal USB port identifies the maximum area allowed for an
infernal USB device. The receiver must fit within this area.

5. Close the workstation and maneuver it to an upright position. Plug in the power cord and turn on
the workstation.

6. Turn on the power on the bottom of the wireless mouse (1) and remove the battery tab on the
bottom of the wireless keyboard. Make sure the mouse and keyboard are within 30 ¢cm (12 in) of
the workstation and away from interference from other devices. Press the connect button on the
mouse (2) for five seconds, then press the connect button on the keyboard (3) for five seconds.
Place them in front of the workstation.

Figure 3-13 Activate wireless keyboard and mouse

Setting up the workstation
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Display options

Adding an external monitor

To connect one additional monitor to the workstation:

1. Determine the correct cable and/or adapter requirements for the monitor:

Monitor Interface Required connection
DisplayPort DisplayPort cable
VGA DisplayPort to VGA adapter with VGA cable
DVI DisplayPort to DVI adapter with DVI-D cable
Dual-Link DVI DisplayPort to DLDV!I adapter with Dual-Link
cable
HDMI DisplayPort to HDMI adapter with HDMI cable

2. Connect the cable and/or adapter DisplayPort end to the DisplayPort connector on the back of the
workstation.

Connect the other end of the cable to the external monitor.

4. Turn on the monitor. If the workstation is running Microsoft Windows and a graphics driver is
installed, the workstation automatically detects the external monitor and uses it as a display.

Customizing the monitor display

You can manually select or change the monitor refresh rates, screen resolution, color settings, font
sizes, and power management settings of the workstation's display or external monitor. Use either the
control panel of the graphics processing unit (MXM card or integrated graphics) or the Windows
Control Panel > Display options.

For more information about customizing your external monitor, refer to the documentation included with
the monitor.

18 Chapter 3 Setting up and using the workstation



Using the workstation as a monitor

The DisplayPort connector on the workstation is bi-directional and lets you use the workstation as a
display for another computer, such as a laptop. The other computer (referred to as the external
graphics source) must have a graphics DisplayPort output connector.

A set of keystrokes on the workstation keyboard toggles the port from output to input and back. While
in output mode, the port drives an external monitor. While in input mode, an external graphics source
drives the workstation display.

r__i?NOTE: This feature is only supported on the Microsoft Windows operating system.

To use the workstation as a monitor:

1. Connect one end of a DisplayPort cable to the external graphics source's DisplayPort connector.
Connect the other end to the DisplayPort connector on the back of the workstation.

Figure 3-14 Connecting the display ports

2. On the workstation keyboard, simultaneously press Ctrl+Shift+S+D (switch display) to enable
the workstation to display output from the external graphics source.

3. To switch back, simultaneously press Ctrl+Shift+S+D on the workstation again. This reverts the
workstation to internal graphics source and places the workstation display in standby mode. On
the workstation, move the mouse or press the space bar to wake up the display.

2»NOTE: This feature relies on the My Display utility, which is subject to change with new software
and driver releases. To download the latest software and driver, go to http://www.portrait.com/
dtune/hpw/enu/upgrade_instructions.html.

Display options
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Using the Webcam

The webcam is a UVC (USB video class) device. It works automatically with any webcam software
(such as YouCam or Skype).

A white activity LED is on when the webcam is active. Optimal performance of the fixed-focus lens is at
0.5 meters.

A dial at the top of the workstation lets you:
e  Adjust the camera angle.

e Disable the camera by turning the dial all the way toward the front of the workstation. A red stripe

in the camera viewport indicates the lens is pointing straight down into the chassis. The user is not
visible.

Installing optional components

You can install additional components such as memory, hard drives, and PCle Mini Cards in your
workstation.

e To view component installation videos, go to http://www.hp.com/go/sml.

e  For installation guidelines and technical information, refer to the HP Z1 Workstation Maintenance
and Service Guide at http://www.hp.com/support/workstation_manuals.

Security

You can secure your workstation by attaching a lock to the cable lock slot.

The workstation includes several security features to reduce the risk of theft and to warn of chassis
intrusion. Refer to the Maintenance and Service Guide for information about additional hardware and
software security features available for your system.

Product recycling

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries.

For information about recycling HP components or products, see http://www.hp.com/go/recycle.
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4 Setting up and restoring Microsoft
Windows

This chapter provides setup and update information for the Microsoft Windows operating system. It
includes these topics:

Topics

Setting up the Microsoft operating system on page 21

Restoring the operating system with HP Recovery Manager
on page 22

r__":"‘/f’NOTE: Atter you set up the operation system, you should make sure the latest BIOS, drivers, and
software updates are installed on the workstation. Refer to the chapter on updating the workstation.

/\ CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

Setting up the Microsoft operating system

Your workstation shipped with the Microsoft Windows 7 operating system (OS). The operating system
installs when you power up the workstation for the first time. This process takes approximately 5 to 10
minutes. Carefully follow the on-screen instructions to complete the installation.

/\ CAUTION: Atfter installation has started, do not turn off the workstation until the process is complete.

Turning off the workstation during installation can damage the installation and operation of the
software.

For complete installation and configuration instructions, go to http://windows.microsoft.com/en-US/

windows7/help. Additional information is available in the online help tool after you successtully install
the operating system.

Installing or upgrading device drivers

You must install the appropriate device drivers before you install hardware devices. Follow the
installation instructions that came with the device. For optimum performance, your operating system
must have the most recent updates, patches, and software fixes. For additional driver and software
update information, refer to the chapter on updating the workstation.

Setting up the Microsoft operating system
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Transferring files and settings

The Microsoft Windows operating system offers data migration tools that help you select and transfer
files and data from one Microsoft Windows-based computer to another.

For information on these tools, go to http://www.microsoft.com.

Restoring the operating system with HP Recovery

Manager

22

The Microsoft Windows 7 operating system can be reinstalled using HP Recovery Manager, a tool
that reinstalls the Windows operating system and device drivers (for devices included with the system)
to a nearfactory state.

If you ordered HP Recovery Manager with your workstation, the restore media is included with your
workstation components. If you did not order it, call HP support and request an HP Recovery Manager
media kit.

/\ CAUTION: Restoring the operating system does not restore data. Before you restore the operating

system, back up your data using the method and media of your choice.

The HP Recovery Manager process deletes all information on the primary hard drive, including all
partitions.

To restore Windows 7:
1. Boot from disc 1 of the HP Recovery Manager set.
2. Follow the prompts to restore your operating system.

Some applications might not be restored using this process. If an application is not restored, install it
with the appropriate installation media.

2»NOTE: Microsoft Windows 7 also provides a backup and restore application. To learn more, go to
http://www.microsoft.com.
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5 Setting up and restoring Linux

HP offers a variety of Linux solutions for HP workstation customers:

e  HP certifies and supports Red Hat Enterprise Linux (RHEL) on HP workstations.

e  HP certifies and supports SUSE® Linux Enterprise Desktop (SLED) on HP workstations.
e HP offers a SLED 11 preload on some Z series workstations.

This chapter describes how to set up and restore the Linux® operating system. It includes these topics:

Topics

HP Installer Kit for Linux (HPIKL) on page 24

Setting up Red Hat Enterprise Linux on page 24

Setting up SUSE Linux Enterprise Desktop (SLED) on page 26

Proprietary graphics drivers on page 27

E/?NOTE: After you set up the operating system, make sure the latest BIOS, drivers, and software
updates are installed. Refer to the chapter on updating the workstation.

/\ CAUTION: Do not add optional hardware or third-party devices to the workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

HP Linux Support Matrix

Not all release streams are supported on particular platforms. To find out which streams are supported
on your workstation. refer to the Linux certification and support matrix:

1. Go to http://www.hp.com/linux.

2. In the Platforms tab, select HP Workstations.
3. Select Certification Matrix.
4. Go to the Red Hat or SUSE tab.
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HP Installer Kit for Linux (HPIKL)

The HP Installer Kit for Linux helps users install certified versions of RHEL or SLED on HP workstations. It
is available as an operating system option on all HP workstations. The kit:

Contains tested drivers that augment and/or replace those found in RHEL or SLED to enable
proper use and behavior on HP workstations.

Does not include Linux operating system, which must be purchased separately from Red Hat or
SUSE. To view supported configurations and operating systems, go to http://www.hp.com
support/linux_hardware_matrix.

The HPIKL option includes a FreeDOS preload. This operating system option accommodates those who
have a customized Linux distribution, or who have a licensed version of RHEL or SLED and would like to
install the HP-recommended driver additions.

The kit also can be downloaded:

N ok w b

Go to http://www.hp.com/support/workstation swdrivers.

Select your workstation model.

Select the desired operating system.

Select your software/driver language, then click the Software quick jump link.

Click the Obtain Software link for the appropriate package (typically the most recent revision).
Click I Agree to accept the terms of the license agreement.

Download the software ISO image and save it on a disk. This disk is your HP driver CD.

Setting up Red Hat Enterprise Linux
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HP Z series workstations are certified and supported on RHEL streams appropriate to the hardware
technology.

For details of RHEL support for a particular platform, see the Hardware Support Matrix for HP
Linux Workstations at http://www.hp.com/support/linux_hardware matrix.

For information about Red Hat certifications on HP workstations, go to
https://hardware.redhat.com.
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HPIKL driver CD

Recent versions of Red Hat Linux typically require only driver updates with minor fixes to support HP
workstations. These releases can usually be supported with the HPIKL driver CD, which can be used as
a post-installation utility for the standard Red Hat Linux install.

After you complete the standard Red Hat install and restart the system, a Red Hat first-boot utility runs.
After you specify a number of settings (such as the security level, time and date, root password, user
accounts), the utility lets you to load additional CDs.

The driver CD is used during this phase. All content added by HP is in the /HP directory on the CD.
You can use it to build your own image or to browse the HP content.

2»NOTE: Some installations may encounter problems if they are performed with a DisplayPort
connection to the monitor. This is because the default drivers that the OS installers use do not support
DisplayPort functionality. If you experience problems, try overriding the monitor choice for DisplayPort
during the start of the install and using the VESA driver instead. You can then set up the DisplayPort
monitor later.

Installing with the HP Red Hat Linux driver CD

1. If you do not have the appropriate HP driver CD for a supported stream, create one (see HP

Installer Kit for Linux (HPIKL) on page 24.

2. |Install the operating system using the optical media included in the Red Hat Linux box-set.

3. If you have a Red Hat driver disk for the OS version you are installing, enter 1inux dd on the
initial install splash screen, and then press Enter.

4. When asked if you have a driver CD, select Yes. Place the Red Hat driver disk in the drive, and
select the appropriate drive :hd[abcd]. Continue the normal installation.

5. After successfully installing the operating system, reboot the workstation.

e  RHEL 5: the Red Hat Setup Agent (also known as firstboot) automatically starts. At the
Additional CDs screen, insert your HP driver CD and select Install. When the driver
installation task is completed, continue following the prompts until the operating system is
successfully installed.

e  RHEL 6: Insert your HP driver CD. The HPIKL installation software automatically starts. Follow
the prompts to install the contents.

Warranty

As part of the HP workstation hardware warranty, HP provides software configuration and installation
support for certified versions of Red Hat Linux for up to 90 days from date of purchase.

Setting up Red Hat Enterprise Linux

25



Setting up SUSE Linux Enterprise Desktop (SLED)

HP offers a 64-bit SLED 11 preload on some Z series workstations and supports 64-bit SLED 11 on
other workstations.

Various versions of SLED are certified and supported by Novell on HP workstations. For more
information, refer to the Novell certification bulletin search page at http://developer.novell.com/

yessearch.

Setting up preloaded SLED

To set up SLED on systems preloaded with the operating system:
1. Start the workstation.

2. When prompted, enter the workstation installation settings: password, network, graphics, time,
keyboard settings, and SUSE Customer Center Configuration.

E’%NOTE: You can activate your SUSE subscription from the SUSE Customer Center Configuration
screen. To view the full SUSE Customer Center documentation, go to http://www.suse.com/
documentation and select your operating system.

Installing SLED with the CD Installer Kit

1. If an HP driver CD did not come with your workstation, create one (see HP Installer Kit for Linux
(HPIKL) on page 24.

2. |Install the operating system using the CDs or DVDs included in the SUSE box-set.
After successtully installing the operating system, reboot the workstation.

4. Insert your HP driver CD. The HPIKL installation software automatically starts. Follow the prompts to
install the contents.

Warranty

HP provides configuration and installation support for SLED 11 on Z series workstations for up to 90
days from date of purchase. Novell also provides support for all versions of SLED that are certified on
HP workstations.
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Restoring SLED (preloaded systems only)

The SLED restore media is required to restore the Linux operating system. To create restore media:

1. Click the SUSE ISO icon on the desktop to go to the /iso folder. This folder contains all iso images
used to preload your workstation.

2. Follow the instructions in the readme file in this folder to copy the ISO image file onto optical
media.

3. Store the media in a safe place. If your workstation experiences a hard drive failure, use the ISO
recovery images tor restore your operating system.

/\ CAUTION: Restoring the operating system does not restore data. Back up your data using the
method and media of your choice.

Proprietary graphics drivers

Most HP workstations can be ordered with graphics cards that have been through extensive verification
by HP. See the Hardware Support Matrix for HP Linux Workstations at http://www.hp.com/support/
linux_hardware matrix for a list of supported cards.

2»NOTE: Not all graphics cards are available on every workstation. Limitations generally occur for
cards that consume large amounts of power in lower-power workstations.

Proprietary graphics drivers supported by HP and the graphics vendors are available with the HP
Installer Kit for Linux, with the SLED 11 preload on Z series workstations, and from HP Workstation
Support at http://www.hp.com/go/workstationsupport.

These proprietary drivers are not a standard part of the RHEL or SLED distributions because they are not
open source. Driver revisions more recent than those at the HP support website are supported directly
by the vendor.
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6 Updating the workstation

HP is constantly working on improving your total workstation experience. To ensure that the workstation
leverages the latest enhancements, HP recommends that you install the latest BIOS, driver, and software
updates on a regular basis.

Updating the workstation after first boot

After successfully booting the workstation for the first time, you should follow these guidelines to ensure
that the workstation is up-to-date:

e  Ensure that you have the latest system BIOS loaded. See Upgrading the BIOS on page 28.

e  Ensure that you have the latest drivers for your system. See Upgrading device drivers
on page 29.

e  Become familiar with your available HP resources.

e  Consider a subscription to Driver Alerts at http://www.hp.com/go/subscriberschoice.

Upgrading the BIOS

For optimum performance, determine the BIOS revision on the workstation, and upgrade it if necessary.

Determining the current BIOS version

28

To determine the current BIOS version:
1. Press Esc during power-up.
2. Press F10 to enter the F10 Setup utility.

3. Select File > System Information. Note the workstation BIOS version and compare it with the
BIOS versions that appear on the HP website.

E%?NOTE: For procedures for upgrading the BIOS as well as the F10 Setup utility BIOS Menu
settings are located in the HP Z1 Workstation Maintenance and Service Guide at
http://www.hp.com/support/workstation_manuals.
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Upgrading BIOS

To find and download the latest available BIOS, which includes the latest enhancements:

1. Go to http://www.hp.com/go/workstationsupport.

. Select Download Drivers and Software from the left menu column under Tasks.

Follow the instructions to locate the latest BIOS available for the workstation.

If the BIOS on the website is the same as the version on your system, no further action is required.

aua A O

If the BIOS on the website is a version later than the one on your system, download the
appropriate version for the workstation. Follow the instructions in the release notes to complete the
installation.

Upgrading device drivers

If you install a peripheral device (such as a printer, display adapter, or network adapter), confirm you
have the latest device drivers loaded. If you purchased your device through HP, visit the HP website to
download the latest drivers for your device. These drivers have been tested to ensure the best
compatibility between your device and your HP workstation.

If you did not purchase your device from HP, HP recommends visiting the HP website first to see if your
device and its drivers have been tested for HP workstation compatibility. If no driver is available, visit
the device manufacturer's website to download the latest drivers.

To upgrade device drivers:

1. Go to http://www.hp.com/go/workstationsupport.

2. Under Tasks in the left column, select Download Drivers and Software.
3. Follow the instructions to find the latest drivers available for the workstation.

If a needed driver is not found, see the website of the manufacturer of the peripheral device.
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7 Diagnostics and Minor
Troubleshooting

Calling technical support

30

At times you might encounter an issue that requires technical support. When you call technical support:

Have the computer readily accessible.

Write down the computer serial numbers, product numbers, model names, and model numbers
and have them in front of you.

Note any applicable error messages.

Note any add-on options.

Note the operating system.

Note any third-party hardware or software.

Note the details of any blinking LEDs on the front of the computer (tower and desktop
configurations) or on the side of the computer (all-in-one configurations).

Note the applications you were using when you encountered the problem.

@NOTE: When calling in for service or support, you might be asked for the Product Number (example:
PS988AV) of the computer. If the computer has a Product Number, it is generally located next to the
10- or 12-digit Serial Number of the computer.

@NOTE: On most models, the serial number and product number labels can be found on the top or
side panel and at the rear of the computer (tower and desktop configurations) or on a pull-out card on
the side of the display (all-in-one configurations).

For a listing of all worldwide technical support phone numbers, go to http://www.hp.com/support,
select your region, and click Connect with HP in the upper-right corner.
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Locating ID labels
To assist in troubleshooting, product, serial, and authentication numbers are available on each

computer.

e  All workstations have a serial number (unique for each workstation) and product number. Have
these numbers available when you contact support.

e The Certificate of Authentication (COA) is used for Windows-preinstalled systems only.

e A Service label shows the Build ID and FeatureByte strings, which are needed for system board
replacement.

In general, these labels can be found in these locations (your computer may look different):
e  On the top, rear or bottom of the chassis (tower and desktop configuration)
e  On a pull-out card on the side of the display (all-in-one configuration)

Figure 7-1 Tower and desktop label locations

Figure 7-2 Allin-one label locations
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Locating warranty information

To locate base warranty information, see http://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, see http://www.hp.com/go/lookuptool.

To extend a standard product warranty, visit http://www.hp.com/hps/carepack. HP Care Pack
Services offer upgraded service levels to extend and expand a standard product warranty.

HP troubleshooting resources and tools

This section provides information on the HP Help and Support Center, E-support, and Helpful Hints for
troubleshooting.

HP Support Assistant

HP Support Assistant (Windows 7 systems only) helps you maintain workstation performance and
resolve problems. HPSA provides automated updates, onboard diagnostics, product information, and
guided assistance to help maintain optimum workstation performance. To access HPSA, click Start >
All Programs > HP Help and Support > HP Support Assistant.

@NOTE: HP Support Assistant is not available on Linux.

E-support
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Online access and support resources include Web-based troubleshooting tools, technical knowledge
databases, driver and patch downloads, online communities, and product change notification services.

The following Web sites are also available to you:

e  hitp://www.hp.com—Provides useful product information.

e  hittp://www.hp.com/support/workstation manuals—Provides the latest online documentation.

e  hitp://www.hp.com/go/workstationsupport—Provides technical support information for
workstations.

e  hitp://www.hp.com/support—Provides a listing of the worldwide technical support phone
numbers. Access the telephone numbers by visiting the Web site, then select your region, and click
Contact HP in the upper-left corner.

e  hitp://www.hp.com/support/workstation_swdrivers—Provides access to software and drivers for
workstations.

Chapter 7 Diagnostics and Minor Troubleshooting


http://www.hp.com/support/warranty-lookuptool
http://www.hp.com/go/lookuptool
http://www.hp.com/hps/carepack
http://www.hp.com
http://www.hp.com/support/workstation_manuals
http://www.hp.com/go/workstationsupport
http://www.hp.com/support
http://www.hp.com/support/workstation_swdrivers

Troubleshooting a problem

To help you troubleshoot problems with your system, HP provides the Business Support Center (BSC).
The BSC is a portal to an extensive selection of online tools. To access BSC and troubleshoot a problem
with the workstation, complete the following:

1. Visit http://www.hp.com/go/workstationsupport.

2. Under the Business Support Center menu on the left, select Troubleshoot a problem.

3. Under Select your product (center window), select Workstations (under personal
computing).

4. Under Select your product, continue with selections as appropriate to the workstation series
and model, and to the problem you are troubleshooting.

Instant Support and Active Chat

HP Instant Support is a set of Web-based support tools that automate and speed up the resolution of
desktop computing, tape storage, and printing problems.

Active Chat enables you to electronically submit a support ticket to HP over the Web. When you submit
a support ticket, Active Chat collects information about the computer and pass it to an online support
specialist. The collection of information might take up to 30 seconds depending on the computer
configuration. When you submit a support ticket, you receive a confirmation message containing your
case ID, the support hours for your location, and the estimated time of response.

For more information about HP Instant Support and Active Chat and how to use them, go to
http://instantsupport.hp.com/.

r__":"/%?NOTE: This feature is not available on Linux.

Customer Advisories, Customer and Security Bulletins, and Customer Notices

To find advisories, bulletins, and notices:

1. Visit hitp://www.hp.com/go/workstationsupport.

2. Select the desired product.
3. Under Resources for <your selected product>, sclect See more....
4

. Under Self-Help resources: in the center of the window, choose the desired action and
appropriate information in the scroll list to view the index.

Product Change Notifications

Product Change Notifications (PCNs) are proactive notifications for product changes occurring within a
30-60 day window of the effective date of the change in the manufacturing process. PCNs give
customers advanced notice of changes to their product, such as an updated BIOS version that they may
need to qualify prior to the change taking place. The latest PCNs are located at: http://www.hp.com
go/workstationsupport.
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Helpful hints

At startup

If you encounter a problem with the workstation, monitor, or software, the following general
suggestions might help you isolate and focus on the problem before taking further action.

Verity that the workstation and monitor are plugged into a working electrical outlet.

e  Remove all optical discs and USB drive keys from the drives before powering on the workstation.

e  Verify that the workstation is turned on and the power light is on.

e If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

e  Verify that the monitor is turned on and the green monitor light is on.

e  Turn up the brightness and contrast controls of the monitor if the monitor is dim.

e If the workstation has multiple video sources and only a single monitor, the monitor must be
connected to the source selected as the primary VGA adapter. During startup, the other monitor
connectors are disabled; if the monitor is connected to one of these ports, it will not function after
Power-on Self Test (POST). You can select the default VGA source in Computer Setup (F10).

During operation

e  Look for blinking LEDs on the workstation. The blinking lights are error codes that will help you
diagnose the problem. Refer to the Diagnostic lights and audible (beep) codes section in the
Maintenance and Service Guide for your workstation for information on interpreting diagnostic
lights and audible codes.

e  Press and hold any key. If the system beeps, then your keyboard is operating correctly.

e  Check all cables for loose or incorrect connections.

e  Wake the workstation by pressing any key on the keyboard or the power button. If the system
remains in suspend mode, shut down the system by pressing and holding the power button for at
least four seconds, then press the power button again fo restart the system. If the system does not
shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart,
press the power button to start the workstation.

e  Reconfigure the workstation after installing a non-plug and play expansion board or other option.
Refer to the Hardware installation problems section of this document for instructions.

e Be sure that all required device drivers have been installed. For example, if you have connected a
printer, you must install a printer driver.

e If you are working on a network, plug another workstation with a different cable into the network
connection. There might be a problem with the network plug or cable.

e If you recently added new hardware, remove the hardware and verify if the workstation functions
properly.

e If you recently installed new software, uninstall the software and verify if the workstation functions
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e If the monitor connected to a tower, desktop or all-in-one computer is blank:

o Plug the monitor into a different video port on the computer if one is available. Alternatively,
replace the monitor with a monitor that you know is working properly.

o Verify that the computer and monitor are plugged into a working electrical outlet.
o Verify that the monitor is turned on and the green monitor light is on.
> Turn up the brightness and contrast controls of the monitor if the monitor is dim.

e If the internal display on an all-in-one computer is blank, open the computer and make sure the
graphics card is properly installed.

e Upgrade the BIOS. A new release of the BIOS might have been released that supports new
features or fixes your problem.

e  For more detailed information, see the troubleshooting chapter in the Maintenance and Service
Guide at http://www.hp.com/support/workstation_manuals.

Customer self-repair

Under the Customer Self-Repair program, you can order a replacement part and install the part without
onsite HP technical assistance. Customer self-repair may be required for some components. See
http://www.hp.com/go/selfrepair for information on the program.

E’/{’NOTE: Some components are not eligible for customer self-repair and must be returned to HP for
service. Call HP Support for further instructions before attempting to remove or repair these
components.

Other troubleshooting options

The following additional troubleshooting techniques and tools are located in the Maintenance and
Service Guide at http://www.hp.com/support/workstation_manuals:

e POST Error Codes

e Diagnostic LEDs and audible beep codes
e Troubleshooting scenarios and solutions

e HP Vision Field Diagnostics
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8 Rouvutine Care

General cleaning safety precautions

e  Never use solvents or flammable solutions to clean the computer.

e  Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

e  Always unplug the computer before cleaning the keyboard, mouse, or air vents.
e  Always disconnect the keyboard before cleaning it.

e  Wear safety glasses equipped with side shields when cleaning the keyboard.

leani he chassi
Cleaning the chassis
e  Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the computer.
e To remove light stains or dirt, use plain water with a clean, lintfree cloth or swab.

e  For stronger stains, use a mild dish washing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

e  For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is required because the alcohol
evaporates quickly and does not leave a residue.

e  After cleaning, always wipe the computer with a clean, lintfree cloth.

e  Occasionally, clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.
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Cleaning the keyboard

/\ CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.

o If the keyboard has an on/off switch, turn it off.

e Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the computer.

e Visible debris underneath or between the keys can be removed by vacuuming or shaking.

e Canned, pressurized air can be used to clean debris from under the keys. Use caution because
too much air pressure can dislodge lubricants applied under the wide keys.

e If you remove a key, use a specially designed key remover to prevent damage to the keys. This
tool is available from many electronic supply outlets.

/A CAUTION: Never remove a wide key (like the space bar key) from the keyboard. If these keys
are improperly removed or installed, the keyboard might not function properly.

e Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be careful
not to wipe away lubricants necessary for proper key functions. Allow the parts to air dry before
reassembly.

e Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor

e Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the computer.

e To clean the monitor, wipe the monitor screen with a towelette designed for cleaning monitors or a
clean cloth moistened with water.

/\ CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the
housing and damage a component.

Never use solvents or flammable liquids on the monitor because display or housing damage may
result.
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Cleaning the mouse
1. Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the computer.
2. If the mouse has an on/off switch, turn it off.
Wipe the body of the mouse with a damp cloth.
4. |f the mouse has a:

e Llaser or LED: use a cotton swab dampened with cleaning solution to gently brush out any
dust around the laser or LED, then wipe again with a dry swab. Do not wipe the laser or LED
directly with the swab.

e  Scroll wheel: spray canned, pressurized air in the gap between the scroll wheel and the click
buttons. Do not blow air directly on one spot for very long or condensation can form.

e Roller ball: remove and clean the roller ball, remove any debris from the ball socket, wipe out
the socket with a dry cloth, and reassemble the mouse.
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